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INSTALLATION

System Requirements

PC Hardware Software

Pentium 2GHz PC with 1 GB RAM or higher Works with any Windows® compatible printer (single ® compatible printer (single ®

printer per seat)
4 GB free hard disk space Preformatted print data only in PDF format
CD-ROM PDF Reader
Windows 2000 OS or higher Java Runtime

Internet Connectivity required to operate program

1. Insert MailDoc software disk into CD Drive. (If the disk does not autorun open the CD Drive and select 
Setup.exe). Maildoc Professional Setup will open, close any applications running and press “OK” to 
begin install.

2. Select program directory and then press the computer icon to continue setup.



3. Select program group and press “Continue”

4. Installation will begin.

5. Press “OK” when installation has completed to begin using MailDoc Professional.



PRODUCT REGISTRATION

To begin using MailDoc Professional the product must be registered with the Serial Number pro-
vided. When fi rst opening Maildoc a registration prompt will be displayed, click “OK” to continue.

Fill out the required registration information and click “Register” to send the information.  Upon 
successfully completing the registration Maildoc Professional will be ready for use and a con-
fi rmation e-mail will be sent.



ABOUT MailDocTM Professional

MailDocTM ProfessionalTM ProfessionalTM  adds OMR or BCR marks to your PDF documents, invoices and statements  Professional adds OMR or BCR marks to your PDF documents, invoices and statements  Professional
that are required by OMR/BCR enabled folder-inserters. These OMR/BCR marks tell the folder-inserter 
how the documents should be prepared for mailing. Information such as the number of pages of each 
document and which documents need inserts or require diverting are included in these OMR/BCR marks. 
The marks also ensure the documents are inserted in the envelope in the correct sequence. 

With its driver technology, MailDocTM ProfessionalTM ProfessionalTM  can quickly and effi ciently support a wide variety of  Professional can quickly and effi ciently support a wide variety of  Professional
OMR/BCR folder-inserters. With this software, you can create and save a confi guration fi le or template 
for commonly used documents, enabling re-use of these confi gurations for commonly performed tasks.



ADDING MARKS TO THE FILE

Select File/New to create a new job or File/Open to open a previously saved job or template.

The Confi guration screen will appear. Use the “Select File” button to fi nd your “Input File” or enter the 
fi lename.



You will also need to enter the following information:

• Output File: Enter the fi lename and location for your processed PDF documents with OMR/
BCR added.

• Mark Defi nition: Contains the options of which type of OMR/BCR will be applied to the 
document based on your inserter.

 Predefi ned Mark Defi nition Options:   

  “BCR Advanced Bottom To Top.drv”:

  “BCR Advanced Top To Bottom.drv”:

  “Dual Track Advanced Bottom To Top.drv”:

  “Dual Track Advanced Top To Bottom.drv”:

  “FD7100 Advanced BCR Bottom to Top.drv”:

  “FD7100 Advanced BCR Top to Bottom.drv”

  “FD7100 Advanced OMR Bottom to Top.drv”:

  “FD7100 Advanced OMR Top to Bottom.drv”

  “OMR Advanced Bottom to Top.drv”:

  “OMR Advanced Top to Bottom.drv”:
   

 Top to bottom is the most common reading direction.  In most cases the top edge of the form is leading or entering 
the inserter fi rst, using the “top to bottom” orientation.  In cases when the top edge of the form is trailing or enters the 
inserter last, the “bottom to top” mark orientation is needed. 

• OMR/BCR Location: This determines where the marks will be physically located on the 
documents.  

• Overlay: An overlay is static information which will appear on every page of your document. It 
might include a company logo, graphics or a form layout.

• Divert File Options: Enter the number of pages and a fi lename for the diverted documents, If a 
document is equal to or exceeds the number of pages entered it will be sent to the fi le selected 
for further processing. 

• PDF Options: Select Single sided or Duplexed documents.  If single sided is used only one 
side of the paper will be printed on, if duplexed is selected both sides of the paper will be printed 
on reducing the number of paper sheets used.  Note: duplexed can only be used if your printer 
can duplex print.  
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When you have made your selections, click “OK” to display the imported documents.



Once the document opens, you will need to select your group fi eld. The group fi eld is the unique 
information used to determine where a document begins and ends. In this example, the group fi eld is 
the invoice number. MailDoc will know the previous document is complete when it sees a new invoice 
number.

Select the grouping fi eld by clicking and holding the right mouse button at the top, left corner of the 
information to be selected, and dragging and releasing the mouse button at the bottom, right corner of 
the information. A black box will appear around the selected fi eld. The text in the box will be displayed 
in red. 

SELECTING THE GROUP FIELD



GROUPING CRITERIA

Grouping criteria can be used when a repeating value is not present on each page.  For example if 
there is no invoice number available a date, salutation or page number that is present only on the fi rst 
or last page of a document can be used to separate each set.  In the sample below the page number is 
used.  In this case a box is drawn around the page # fi eld on the document, “Start Text” is selected and 
“Page # 1” is typed into the “Match Text” fi eld (Note: the “Match Text” fi eld is case sensitive.). 



SELECTING INSERT & DIVERT FIELDS

MailDoc Professional allows you to mark selective inserts and diverts for your document based on 
the criteria you select. As an example, a selective insert allows you to instruct the inserter to add a 
particular promotion or notice to a specifi c envelope, such as a bonus coupon to a customer in a certain 
zip code.
  
The divert function allows you to instruct the inserter to place the document in the folder-inserter’s divert 
tray instead of placing the document into an envelope. For example, you might wish to divert invoices 
with a zero balance so they do not get mailed.

To select a fi eld for Inserting or Diverting, choose the appropriate item from the Edit Menu. Only the 
number of selective inserts and diverts available for the “Mark Defi nition” selected are displayed on the 
Edit menu.



Use the mouse to create a box around the information to be used for each insert and divert, then click 
the Properties button.

The Properties box allows you to set Boolean conditions (i.e. Equal to, Less than, Greater Than, etc..) 
for each selective insert and divert. You can set up to 5 criteria for each insert or divert. 

In the example shown, any address that contains Zip Code “03820” will receive an additional insert.



The Boolean conditions available are described below.

Operator Field Command

= Numeric Number in the box equals the comparison value.

> Numeric Comparison value is less than displayed value. 

< Numeric Comparison value is greater than displayed value.

<> Numeric Comparison value is between displayed values. 

Equals Text Comparison value exactly matches displayed text.

Not Equal Text Comparison value does not match displayed text. 

InString Text Comparison value appears within displayed text. 

NotInString Text Comparison value not within displayed text. 

StartsWith Text Comparison value at beginning of displayed text.

EndsWith Text Comparison value at end of displayed text.



E-MAIL SETTINGS

MailDoc Professional can e-mail invoices directly to customers at the end of the sorting process. To 
utilize this feature the e-mail address must be present on the document to be sent. 

Select “Edit”, from the drop down list select “Divert To File” then select the File number to be diverted 
to.  In the example below “File 1” has been selected. 



Highlight the area containing the e-mail information.  In the example below the box containing all the 
contact information is highlighted to allow for e-mail addresses of varying lengths.  With the information 
highlighted click on the “Properties” button to defi ne the criteria.



The “Criteria for Divert to File” will open.  The “Selection” box contains the information selected on the 
previous screen. In the “Divert Conditions” choose the divert value, in this case it will be “CONTAINS”.  
Select the “Add” button next to the “one of the list values” fi eld. 

Enter the search value, in this example the “@” symbol is used to fi lter for e-mail addresses. Press “OK” 
after entering the value.



Check the “E-mail Divert Files” box and then press the “E-mail Settings” buttons

Enter your sender e-mail information along with subject and message.  In addition a delay between 
e-mails can be set and a “Report E-mail” can be added.  Press “Apply” to save the information. 



SAVING YOUR SETTINGS

Once you have completed the selective inserts, diverts, grouping settings etc., you can save your job 
by using the “File/Save”, “File/Save As” or “File/Save Template” options.  “Save” or “Save As” will save 
the fi le with all OMR/BCR settings along with input and output fi le settings.  “Save Template” saves just 
the OMR/BCR settings without the input and output settings for use with other input and output fi les, 
eliminating steps and saving time for recurring jobs that have the same layout but with different data.



PRODUCING THE MARKED DOCUMENT

To process your document, select “Process” from the menu bar.

Once the “Process” screen appears, you can click “Start” to generate the appropriate marks in the 
output fi le. Selecting the “Test File” check box will generate comments beside each mark describing the 
marks’ instruction.



The Summary Report will appear on the screen once the fi le has been processed and marks have been 
added. The Summary Report for this job is displayed below.  The report can be printed and/or saved.  
Close the screen when fi nished.

The top of the sample output fi le is shown below. The marks added by the software have been 
highlighted.

 

 

  

 

 

  

 

 

ABCCO 

INVOICE 

(603) 749-5807 
Warehouse: 
Telephone: 

78381 

Customer No. 

Invoice No. 

Formax OMR/BCR 
44 Ventures Drive 
Dover, NH 03820 
USA 

Quantity 
Order 

Resale # Ordered By PO # SO # Order Date Invoice Date 

Salesperson Terms F.O.B 

Contact: Contact: 
Telephone: Telephone: 

ABC COMPANY 
1 UNIVERSAL LANE 
CONCORD, NH 03820 

ABC COMPANY 
1 UNIVERSAL LANE 
CONCORD, NH 03820 

Quantity 

  

MAIN 

Bill To: Ship To: 

603-343-1254 603-343-1254 
RICHARD DAVIS RICHARD DAVIS 

Ship Via 

Shipped Item Number 
Item Description 

Extended 
Price 
Unit 

Price 

 

 

 

  

 
 

Tax 

YELLOW NET 30 DAYS 

08/12/2009 08/12/2009 
 

    393-8731 U of M: Each  1  55.13  55.13 N  1 
SAFETY COVER     

385-0004 U of M: Each  1  7.88  7.88 N  1 
CLUTCH HANDWHEEL BASE PLATE     

393-8731 U of M: Each  1  55.13  55.13 N  1 
SAFETY COVER     

385-0004 U of M: Each  1  7.88  7.88 N  1 
CLUTCH HANDWHEEL BASE PLATE     

382-0009 U of M: Each  1  1.69  1.69 N  1 
HOOK VELCRO PAD     

393-8731 U of M: Each  1  55.13  55.13 N  1 
SAFETY COVER     

385-0004 U of M: Each  1  7.88  7.88 N  1 
CLUTCH HANDWHEEL BASE PLATE     

  

Page # 

Print Date 
Print Time 

08/13/2009 
02:32:13 PM 
1 

                               

Please Make Payment to:  Formax OMR/BCR 
44 Ventures Drive 
Dover, NH 03820 
USA 



SETTING OMR MARK DEFINITIONS

To change the current mark defi nitions or to create a new set of defi nitions, select OMR Mark 
Defi nitions from the Tools menu.

From this window, you may specify the dimensions of a mark, as well as the spacing between marks. 
You may also specify Dual Track. Descriptions of each fi eld appear on the next page.



• Mark Length – Sets the length of the OMR marks.

• Mark Weight – Sets the width of the OMR marks.

• XSpacer – Defi nes the distance between each subsequent mark within the X-Axis (width) of the XSpacer – Defi nes the distance between each subsequent mark within the X-Axis (width) of the XSpacer
document.

♦ XSpacer = 0 - OMR marks are drawn from the top of the page to the bottom or from the bottom of 
the page to the top.

♦ XSpacer > 0 - OMR marks are drawn from left to right. Each subsequent mark will be drawn 
Xspacer units to right of the previous mark.

♦ XSpacer < 0 - OMR/BCR marks are drawn from right to left. Each subsequent mark will be drawn 
Xspacer units

• Yspacer - Defi nes the distance between each subsequent mark within the Y-Axis (length) of the 
document.

♦ Yspacer = 0 - OMR marks are drawn from left to right or from right to left.

♦ Yspacer > 0 - OMR marks are drawn from the top of the page to the bottom.

♦ Yspacer < 0 - OMR marks are drawn from the bottom of the page to the top.

• XSpacerDual – Defi nes the distance between the fi rst track of marks and the second track of marks in the 
X-Axis (width).

♦ XSpacerDual = 0 - OMR marks are drawn from left to right or from right to left, and the second track 
of marks are drawn above or below the fi rst track of marks.

♦ XSpacerDual > 0 - OMR marks are drawn from the top of the page to the bottom or from bottom to 
top, and the second track of marks are drawn to the right of the fi rst track of marks.

♦ XSpacerDual < 0 - OMR marks are drawn from the top of the page to the bottom or from bottom to 
top, and the second track of marks are drawn to the left of the fi rst track of marks

• YSpacerDual - Defi nes the distance between the fi rst track of marks and the second track of marks in the 
Y-Axis (width).

♦ YSpacerDual = 0 - OMR marks are drawn from the top of the page to the bottom or from the bottom 
of the page to the top, and the second track of marks are drawn to the left or right of the marks.

♦ YSpacerDual > 0 - OMR marks are drawn from left to right or right to left, and the second track of 
marks are drawn to the below the fi rst track of marks.

♦ YSpacerDual < 0 - OMR marks are drawn from left to right or right to left, and the second track of 
marks are drawn to the above the fi rst track of marks.



• Dual Track - When selected two tracks of marks will be drawn. (For inserters that support dual OMR 
marks)

• Max # of Pages - Defi nes the maximum number of pages MailDoc will group together to go into one 
envelope, i.e. 5 pages. Any document that exceeds the number of maximum pages will contain a divert 
mark. These sets will be sent to a divert tray or stop in the collating area depending on the inserter model.

Use the fi elds on the right hand side to assign your inserter’s supported marks to a relative position within the 
mark sequence. The sequence of marks should follow the sequence of marks that your inserter expects. A 
description of the mark can be entered into the adjacent text box.

• Start – On every page, Defi nes the beginning position of the OMR code

• Accumulate / Insert – Determines if additional pages are to be pulled or if the set is complete.                
No mark present = Accumulate; Mark present = Insert

• Selective Feed – Tells the inserter to pull a sheet from a specifi ed feeder based on criteria entered.

• Divert/Cont. – This mark stops the system from folding & inserting, ejects the set to the divert tray and 
keeps running.

• Divert/Stop – This mark stops the system from folding & inserting, ejects the set to the divert tray and the 
inserter stops.

• Sequence – Sequence marks number the pages in a stack, to allow the inserter to detect sheets 
accidentally getting out of sequence. If one sequence mark is used the pages will be numbered 1-2-1-2 
etc. If two sequence marks are used the pages will be numbered 1-2-3-4-1-2-3-4 etc. If three sequence 
marks are used, the pages will be numbered 1-2-3-4-5-6-7-1-2-3-4-5-6-7, etc.

• Custom – These marks can be customized for additional functions that may be available on the inserter.

• Present/Deck – This mark ejects fi lled envelopes to alternate exit prior to sealing.  This feature may be 
used for periodic inspection of stuffed envelopes or as an end of run indicator.

• Sealing - If automated sealing is available on the inserter this mark will indicate that the envelope should 
not be sealed.

• Exit Control - If multiple exit options are available this mark can be used to direct where the fi nished mail 
piece is ejected from the inserter.

 • Env. Hopper - If multiple envelope hoppers are available on the inserter this mark will indicate which Env. Hopper - If multiple envelope hoppers are available on the inserter this mark will indicate which Env. Hopper
envelope hopper to pull from.

• Parity – A Parity mark ensures that the number of marks on the page are always even.

• Safety –On every page. Provides extra security, primarily used for paper skew, if the safety mark is not 
read an error code will be displayed on the inserter.

When you have entered the confi guration for your folder-inserter, select Save to retain this information.



SETTING OMR MARK LOCATION FOR NON-FORMAX INSERTERS

OMR Mark size spacing and positions can easily be adjusted to meet the requirements of non-Formax 
Inserters. Begin by selecting the “Mark Defi nitions” from the “Tool” drop down

The “Mark Defi nition” screen will open with default settings.  Select “Create New OMR” from the “Mark 
Defi nition” drop down fi eld and name the new OMR marks in the “Defi nition Name” fi eld.  Then simply 
change the length, width, space between marks, mark positions and defi nitions to meet the criteria of 
the non-Formax inserter.  Press “Apply” and “Save” to save the new OMR.



The example below shows OMR mark defi nitions setup for a non-Formax Inserter.  



SETTING BCR MARK DEFINITIONS

To change the current mark defi nitions or to create a new set of defi nitions, select “Mark Defi nition” from 
the “Tools” menu.

From this window the functions of BCR can be selected including how the multi-page documents are 
grouped, selective feeding options, divert and sequence.



• Grouping of Multiple Page Documents:

  End of Group: Groups document by mark at the end of set

  First of Group: Groups documents by mark at the start of set

  Use End of Job: Mark indicates the end of a job run

• Selective Feeding – Tells the inserter to pull a sheet from a specifi ed feeder based on criteria entered.

• Insert – An insert mark has the inserter feed a sheet from the station specifi ed.

• Divert – A divert mark stops the system from collating and ejects the set to the divert tray.

• Form Sequence within Job – Sequence marks allow the inserter to detect sheets accidentally getting 
out of order with throughout the entire print job.

• Form Sequence within a group – Sequence marks allow the inserter to detect sheets accidentally 
getting out of order within each group of documents.

• Display Barcode Number – Enables the display of the code numbers within the barcode.

• Rotation Angle – Sets the angle of the barcode, horizontal, vertical, left to right, right to left, top to bottom 
or bottom to top.



Opening Saved Files and Templates
To open a saved fi le or template, select “Open” from the “File Menu”.

Product Updates
Product updates are available periodically to enhance the product performance.  To access updates a 
password must fi rst be obtained through Formax.  Press the Help button and select “Download” from 
the drop down menu.  

Enter the password and follow the on-screen directions to complete the download.




